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Warranty and Liability 

 

All Bioneer products are tested under extensive Quality Control procedures. Bioneer guarantees the quality under the 
warranty period. Any problems should be reported immediately.  Liability is conditional upon the customer providing full 
details of the problem to Bioneer. Once the problem occurrs, customers must report to Bioneer within 30 days. 
 
 

QC Testing  

 

Each lot of Bioneer’s product is carefully tested by the quality control team. 

 

 

Notice 

 
Patent Pending  
Exicycler is a trademark of Bioneer Corporation.  
Certain applications of this product are covered by pending or issued patents in certain countries. Because purchase of 
this product does not include a license to perform any patented application, users of this product may be required to 
obtain a patent license depending upon the particular application and country in which the product is used.  For more 
information, please contact Legal manager, Bioneer Corporation, 49-3, Munpyeong-dong, Daedeok-gu, Daejeon 306-
220, Republic of Korea. 
 
Appearance and specification are subjected to change without notice. 
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Before Starting 

 

 

How to Use This Guide 

 

Who This Guide is Written for 

This guide is written for researchers and laboratory staff responsible for installing and maintaining the 

Exicycler™ 96 Real-Time Quantitative Thermal Block. 

 

General Requirements for Installation 

This guide assumes that you: 

 Are familiar with the Microsoft
®
 Windows

®
 XP operating system. 

 Have basic techniques for handling DNA and RNA samples for PCR. 

 Have basic skills of data storage, copying, and pasting in hard drives. 

 Have experience in setting up a network if you want to use any data generated by 

Exicycler™ 96 through a network. 

 

Word Conventions 

 Bold signifies user action such as typing a text or clicking a button. For example: 

Type Test and click OK to move to the next step. 

 Italic represents important words or sentences and is also used for emphasis. For example: 

After analysis, you must save data using Save As. 

 A right arrow in bold (>) separates consecutive commands you select from a main menu or 

shortcut menu. For example: 

File> Config> Scan 

 

Safety and Warning 

The following safety alert words are used in this manual and require a particular level of observation. 

Each alert word is defined as below: 

 

Note: Indicates relevant or helpful information about an instrument, however doesn’t affect instrument 

operation. 

Important: Indicates information that is necessary for proper instrument operation. 

Danger: Indicates an imminently hazardous situation which, if not avoided, could result in serious 

injury. This safety word is used to alert improper instrument operation. 

Warning: Indicates a potentially hazardous situation which, if not avoided, will result in death or 

serious injury if not avoided. 
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How to Use an Instrument Safely 

Refer to this guide when installing or maintaining the Exicycler™ 96 Real-Time Quantitative Thermal 

Block. 

 

How to Obtain More Information 

For more information about Exicycler™ 96 , please visit us online at www.bioneer.co.kr or 

www.bioneer.com. 

 

How to Reach Customer Support 

To obtain prompt customer support, please call us at 1588-9788. You can also obtain technical support 

through www.bioneer.co.kr or www.bioneer.com. 
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Safety Warnings and Cautions 

 

Safety instructions in this guide book are to cover possible dangerous conditions and situations that 

may occur. It is your responsibility to read this guide thoroughly when installing, maintaining, or 

operating Exicycler™ 96. The following safety alert words will be used in this section: 

 

Warning: Hazards or unsafe actions that may result in severe injury. 

Caution: Hazards or unsafe actions that may result in minor injury or damage. 

Warnings: Hazards or unsafe actions that may result in High temperature and Skin burn. 

Warnings: Hazards or unsafe actions that may result in Electronic risk.  

 

 

Location Consideration and Installation 

 

General Instrument Safety  

 

1) Check the power voltage rating before connecting the instrument to an electrical outlet. 

Exicycler™ 96 system is configured for either 110V or 220V (±10%). Using AVR (Automatic 

Voltage Regulator) or UPS (Uninterrupted Power Supply) is recommended for uninterruptible 

power supply. 

2) The Exicycler™ 96 must be grounded for protection against electric shock. If not, it may 

cause serious injury and system damage. 

3) Do not use a loose power cable or connector. An overheated power cable may break and 

lead to a fire or electric shock. 

4) If you use a power extension cable, do not connect too many devices to it and operate them 

at the same time. Overload may occur and cause a fire. 

5) Dry your hands completely when handling a power cord for protection against electric shock. 

6) Do not place any objects in front of the main door of the Exicycler™ 96 that can interrupt door 

operation. 

7) Leave 30 cm space between the Exicycler™ 96 and the wall for proper ventilation. 

8) Do not install the Exicycler™ 96 in a dusty environment to help prevent false operation or 

technical damage. 

9) Keep the Exicycler™ 96 away from heat sources. 

10) The Exicycler™ 96 must not be installed in an area where it is exposed to water or is humid. 

It may cause electric shock, a fire, or system damage. 

11) The Exicycler™ 96 must not be installed in an area where it is exposed to combustible or 

flammable vapor. In the case of a gas leak, open the windows and let fresh air in. Do not 
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operate any electrical switch during a gas leak. It may cause explosion or fire. 

12) Do not disassemble or repair the Exicycler™ 96 yourself. It may cause a fire, electric shock, 

and system damage. A limited warranty does not cover unauthorized alterations or damage 

by abuse. 

 

Installation Safety  

 

1) Place and install the Exicycler™ 96 away from direct sunlight. 

2) It is recommended that you turn off the computer as well as unplug the power cable before 

connecting it to the Exicycler™ 96. When the computer power is on while connecting, the 

communication port connector in either the computer or the Exicycler™ 96 may get damaged. 

3) Make sure that the USB cable is firmly connected between the Exicycler™ 96 and the 

computer. Unstable connection may cause damage of the communication port connector or 

data transfer errors. 

4) The built-in camera in the Exicycler™ 96 is a static-sensitive device. Pay particular attention 

to any cables connected to the Exicycler™ 96 to avoid static damage. 

 

Cautions 

1) Ensure the power cable is clean and connect it firmly to the Exicycler™ 96. 

2) Operate the Exicycler™ 96 in a place where the temperature is always between 15℃ and 

30℃. Poor performance is influenced by extreme temperatures. High temperatures can 

cause mis-operation and poor performance. 

3) Operate the system in a place where the humidity is always between 20 % and 80% with no 

condensation. High humidity conditions can cause corrosion of internal components and low 

humidity can lead to errors. 

4) Do not place any objects behind or by the side of the Exicycler™ 96 that can interrupt 

ventilization and cause errors. 

5) The internal optical components of the Exicycler™ 96 may get damaged if the instrument falls 

or is exposes to excessive physical shock. 

6) Unplug the power cable from the Exicycler™ 96 when not in operation for a long period of 

time to prevent the possibility of fire by overheating. 

 

 

Operation and Maintenance 

 

Warnings 

1) The system can be hazardous if misused. 
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2) Keep the 96-well thermal block area clean to prevent damage and to generate accurate 

experimental data. 

3) After any Real-Time PCR runs including ‘Scan’ or ‘Melting’, allow the Exicycler™ 96 at least 

10 minutes to cool down the light source lamp. Continuous operation without a break will 

reduce the lamp life time and cause errors. 

4) Do not place a piece of paper or a plastic cover under the Exicycler™ 96. It could cause fire. 

5) Do not turn off the Exicycler™ 96 right after a Real-Time PCR run is done. Wait until the 

cooling fan stops running completely. The cooling fan still runs for about 2 minutes to cool 

down the lamp after every Real-Time PCR run. 

6) Do not cover the Exicycler™ 96 with a piece of paper or a plastic cover. It may cause a fire or 

failure. 

7) Set ’Turn off monitor’, ‘Turn off hard disks’, ‘System standby‘, and ‘System hibernates’ to 

‘Never’ using ‘Power Options Properties’ in the Control Panel. Otherwise, data transfer 

between the Exicycler™ 96 and the computer will be interrupted. 

 

 

IMPORTANT:  

Exicycler™ 96 should be operated in clean condition. Contaminants such as dust can cause troubles and reduce the 

life time of Exicycler™ 96. Please prevent dust from coming into Exicycler™ 96. Through removing dust periodically 

from the Exicycler™ 96 system, the life time can be extended. 
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European Safety and EMC Standards (CE) 

 

This instrument meets the requirements of the European Directive for in vitro diagnostic medical 

devices 98/79/EC. This instrument has been tested according to the standards listed below and 

complies with them. 

1) Council Directive 98/79/EC of 27 October 1998 concerning in-vitro diagnostic medical devices 

2) EN 61010-1 [2001] Safety requirements for electrical equipment for measurement, control 

and laboratory use. Part 1: General requirements for safety. 

3) EN 61010-2-010 [2003] Safety requirements for electrical equipment for measurement, 

control and laboratory use. Part 2-010: Particular requirements for laboratory equipment for 

the heating of materials. 

4) EN 61010-2-081 [2001] Safety requirements for electrical equipment for measurement, 

control and laboratory use. Part 2-081: Particular requirements for automatic and semi-

automatic laboratory equipment for analysis and other purposes. 

5) EN 61010-2-101 [2002] Safety requirements for electrical equipment for measurement, 

control and laboratory use. Part 2-101: Particular requirements for in vitro diagnostic (IVD) 

medical equipment. 

6) EN 61326 [1997+A1] [1998+A2] [2001+A3] [2003 Class A] Electrical equipment for 

measurement, control and laboratory use - EMC requirements. 

7) EN 60601-1-2 [2001] Medical electrical equipment. Part 1-2: General requirements for basic 

safety and essential performance - Collateral standard: Electromagnetic compatibility - 

Requirements and tests. 

Compliance is demonstrated by the following mark: 

 

 

 

 

Authorized Representative 

MT Promedt Consulting GmbH 

Altenhofstrasse 80 

D-66386 St. Ingbert 

Germany 

 

Product Use Limitations 

The Exicycler™ system is designed and sold for in vitro diagnostic (IVD) applications in combination 

with the diagnostic kits manufactured by Bioneer and labeled for diagnostic purposes. The Exicycler
TM

 

system can also be used for life science research and other laboratory purposes.
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Introduction 

 

  The Exicycler™ 96 Real-Time Quantitative Thermal Block combines a thermal block in a standard 

96-well format and an innovative fluorescence detector. The detector monitors the fluorescence 

emitted as an indicator of amplified nucleic acid product during each PCR cycle in real time. 

The thermal block is built in the lower part of the Exicycler™ 96, which carries out a thermal cycling. 

The detector is located in the upper part of the Exicycler™ 96, which measures the fluorescence 

emitted from samples in the thermal block in real time and transfers data to the computer for analysis. 

Data transferred from the detector is analyzed with the Exicycler ™ Analysis Software. 

  The Exicycler™ 96 Real-Time Quantitative Thermal Block provides a maximum ramping rate of 

2.5℃/sec, and features various funtions such as time increment, temperature increment, and ramp 

rate control for myriad applications. 

  The Exicycler™ 96 Real-Time Quantitative Thermal Block detector consists of an light source part 

and a detection part. The light source part is an energy source to excite fluorescent dyes. A short arc 

lamp that has a long lifetime is bright, and is implemented. A white-light source is divided into particular 

wavelength groups by band path filters. The band path filters that are set in the Exicycler™ 96 covers 

within 480 to 690 ㎚ and works as a set consisting of an excitation and an emission filter. Five of the 

filter sets are provided for various applications. Therefore, adding additional band path filters is not 

required. 

  The detector, a hight sensitive 2D CCD camera, provides high sensitivity and detects fluorescence 

signals from a 96-well plate in the thermal block all at one time. This simultaneous detection has a 

great advantage over sequential detection. The innovative detector invented by Bioneer has also 

reduced well-to-well variation and has minimized dye-to-dye interference, therefore providing more 

accurate results. Bioneer’s state-of-the-art technologies applied to the Exicycler™ 96 are to generate a 

uniform light surface over the thermal block, to detect multiple fluorescent signals emitted from various 

dyes through the light surface, and to separate the signals within a selective wavelength range of each 

dye. 

  The Exicycler™ 96 Real-Time Quantitative Thermal Block features an auto loading function for 

automation reducing errors and Self-diagnosis for diagnosing systematical conditions of the Exicycer™ 

96 for users convenience. The Exicycler™ 96 Software is composed of three main programs. 

1) A set up program for calibration, diagnosis and confirmation of the instrument’s information. 

2) An operation program for creating a protocol, assigning a probe and plate, saving & displaying 

data while operating the Exicycer™ 96. 

3) An analysis program for data analysis. The analysis program includes Absolute Quantification, 

Relative Quantification, Multi-Relative Quantification, SNP genotyping, and Existentence / 

Nonexistentence. Analysis and is applicable to Gene expression, Quantification of cell and virus, 

and SNP genotyping. 
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System Components and Specifications 

 

Exicycler™ 96 Quantitative Thermal Block is warranted by Bioneer against manufacturing defects in 

materials and workmanship for a limited warranty period of one year. Bioneer will charge for repairing 

products for the following conditions: 

 Failures due to work by the customer himself/herself 

 The product is repaired after expiry of the warranty period. 

Before you install the Exicycler™ 96, check the shipped materials with the system component list 

below:  

 

 

System Components 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Cat. No. A-2060 Check 

Main instrument 1 □ 
USB 2.0 high speed cable 1 □ 
Power cable 1 □ 
Software 1 CD □ 
Operations Guide 1 □ 
96 well reaction plate 1 pack □ 
Optical sealing tape 1 pack □ 
Optical tape sealing applicator 1 □ 
Warranties 1 □ 
Customer Service Request Form 1 □ 
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Specifications 
 

Physical specifications 

Dimension (㎜) 355(W) X 540(D) X 470(H) 

Weight (㎏) 30 ㎏ 

Sample capacity size 96-well plate / 0.2 ㎖ micro tubes 

Sample volume 20~100 ㎕ (50 ㎕ recommended) 

Input voltage 100 ~ 240 VAC 

Frequency 50 / 60 ㎐ 

Power 850 Watts (Fuse : 250 V, F10AL) 

Operating specifications 

Method of heating / cooling Peltier 

Temperature range 4.0℃ ~ 99.9℃ 

Temperature accuracy  0.3℃ 

Temperature uniformity  0.5℃ 

Ramping rate Max. 2.5℃/sec 

Lid temperature Within 90 ~ 120℃ 

Temperature increment range 0.1℃~9.9℃ 

Time increment range 1 sec ~ 60 sec 

Ramp rate control 0.1℃/sec 

Operating temperature 15 ~ 30℃ 

Operating humidity 20 ~ 80%, no condensation 

Communication USB 2.0 high speed 

Operating OS 
Window XP & Windows 7 (32 bit OS only, 

either in English or in Korean) 

Optical Part 

Light source Short arc lamp 

Wattage 120 W 

* 
Lamp life time 3,000 hours 

Sensor 16 bit 2D CCD 

**
 Excitation Filter / Emission Filter 5 Set 

 
* Continuously turning on and off the lamp reduces the lamp life time. 
* The lamp generates heat when it starts. Make sure that you turn off the Exicycler™ after a cooling 

fan stops running. It usually takes about 2 minutes to stop the cooling fan. Please refer to a chart 
below for more information about filter sets. 
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† Filter sets 

 

 

 

 

 

 

 

 

 

 

Warning: 

Chemical hazard: Such the florescent dyes may cause eye and skin irritation, and respiratory tract irritation. To treat 

them, read the MSDS before use and follow the instructions if swallowed or inhaled. Wear appropriate protective 

eyewear, clothing, and gloves. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Position Excitation (㎚) Emission (㎚) Set Fluorescent dye 

1 Blank Blank 1 - 

2 490 520 1 FAM, SYBR Green I 

3 520 550 1 JOE, TET 

4 550 580 1 TAMRA, CY3 

5 580 610 1 Texas Red, ROX, Red610 

6 630 680 1 CY5, Red670 



 
Exicycler™ 96 Real-Time Quantitative Thermal Block 

 

 
 

 
14 

www.bioneer.com 

 

 

 

System Views 

 

Front view      Rear view 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Inside view 

 

 

 

 

 

 

 

 

 

 

 

 

 

USB Communication cable 

On/Off Switch 

DOOR 

POWER and Status LED 

 Ventilation hole 

96-well thermal block 
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Installation 

To run the Exicycler™ 96 Real-Time Quantitative Thermal Block, camera driver and operation software 

should be installed in a computer. When first installing the camera driver and operation software, or re-

installing these components, please see below for instructions on how to install them yourself. 

 

Setting Up the Computer 

Exicycler™ 96 Real-Time Quantitative Thermal Block operates through a computer. Therefore, to 

install Exicycler™ 96, a computer or a laptop is necessary. The computer must meet the following 

computer requirements listed below. Please contact Bioneer Customer Service Center if you have any 

questions regarding installation. 

 

Computer Requirements 

 Intel Dual Core E2160 (1.8GHz) or higher 

 Window XP Operating System for Korean or English Version (Service pack 2 or later) 

 1.0GB RAM or higher 

 1280 * 1024 screen resolution 

 USB 2.0 high speed port 

 20GB Hard disk drive minimum 

 Microsoft Excel (Option) 

 

For questions regarding problems with the computer or operating system, please contact the computer 

manufacturer. 

 

1) The computer must have at least one communication port for USB data transfer. 

2) It is recommended that antivirus software be installed in order for the Exicycler™ 96 to operate 

safely. A firewall should also be setup to prevent unwanted information coming in from external 

nextworks. Please contact your IT department to setup the antivirus software and firewall. 

3) It is recommended that a memory stick not be installed when Exicycler™ 96 is running. It may 

cause a technical problem between Exicycler™ 96 and the computer. 
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Connecting the Computer and Exicycler™ 96 

There are a main power connector and a communication port connector (USB) in the rear of 

Exicycler™ 96. The computer should be turned off when connecting to the Exicycler™ 96 to prevent 

any damages to the communication port. Please see below for instructions on how to connect 

Exicycler™ 96 to the computer. 

 

1) Unpack the Exicycler™ 96 and make sure all components are included. Refer to the list of 

components below. 

2) Exicycler™ 96 must be installed in an area where it is not exposed to sunlight and must be set on a 

stable and level surface. 

3) Set up the computer in the installation site. 

4) Place the Exicycler™ 96 in the installation site carefully. 

5) Connect the USB 2.0 cable to the USB connector on the back of Exicycler™ 96, then to the 

computer. 

6) Connect the power cable to the Exicycler™ 96, then to the receptable wall circuit. 

 

 

List of Components 

 

 

 

 

 

 

 

 

 

 

 

 

* Provided according to country standard. 

 

 

 

 

 

Cat. No. A-2060 Check 

Main instrument 1 □ 
USB 2.0 high speed cable 1 □ 
Power cable* 1 □ 
Software 1 CD □ 
Operations Guide 1 □ 
96 well reaction plate 1 pack □ 
Optical sealing tape 1 pack □ 
Optical tape sealing applicator 1 □ 
Warranties 1 □ 
Customer Service Request Form 1 □ 
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Installing the Operation and Analysis Software  

To run the Exicycler™ 96 Real-Time Quantitative Thermal Block, the operation software and the 

camera driver must be installed in the computer. When first installing the operation software and the 

camera driver, or re-installing these components, please see instructions below on how to install them 

yourself. In case of running the software for only data analysis purpose, please refer to this section for 

software installation. 

 

IMPORTANT: 

Do not power on the Exicycler™96 unless you have installed the Operation and Analysis Software and a camera driver. 

First install the Operation Software and then the camera driver. 

 

To install Bioneer Package and Exicycler3 softwares for an Exicycler
TM

 96 device under Window 7, follow the 

instructions below: 

 

 If a previous version of software has been installed on your computer, please remove the programs and folders 

from the computer (Refer to ‘Troubleshooting 4’). Remaning program folders may cause errors during 

installation. This section is for the first time installation or re-installation of the software. 

 The Bioneer Package has to be installed prior to installing Exicycler3 software.  The procedures of Bioneer 

Package installation is described below. 

 

1) Power on the computer, but not the Exicycler™ 96 

Real-Time PCR machine. Place the Exicycler™ 96 

installation CD on the CD-ROM. Go to ‘Bioneer 

Package’ folder in the CD drive and run Setup.exe 

 

 

 

 

 

2) To install Bioneer Package, click Next . The 

installation will proceed in C:\Exicycler3. 
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3) Enter the desired name in the User Name box and 

Company Name box. 

 

 

 

 

 

 

 

4) Select a setup type to install. Complete is 

recommended for installing all program features. 

Custom install is recommended only for advanced 

users. Click Next. 

 

 

 

 

 

5) The InstallWizard is ready for the installation. If you 

want to review or modify your settings, click Back. 

Click Install to start installation.  

 

 

 

 

 

 

 

6) This process takes several minutes. Please do not 

cancel until the installation is complete.  
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7) After the installation is completed. Please click 

Finish to finish the installation Shiled Wizard. 

 

 

 

 

 

 

 

 

 

8) The R program is also needed for Exicycler software. 

If you click OK, the installation will begin. 

 

 

 

 

 

 

 

 

9) R program will be installed automatically. Please wait 

until the installation is completed. 

 

 

 

 

 

 

 

 

10) Click OK for installing R(D)COM interface. 
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11) The R icon (right) will be shown on the Desktop 

when the installation is successfully complete.  

 

 

 

 

 

 

12) The folders shown here are created after the 

installation has finished. Please confirm the 

‘Bioneer_Package’ and sub folders. 

 

 

 

 

 

 

 

 

 

 

 

13) In order to install ‘.NET Framework 1.1 Package’, 

run dotnetfx_eng.exe file of the 

C:\Bioneer_Package\Net11 folder. 
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14) The message to confirm the installation of ‘.NET 

Framework 1.1 Package’ is displayed, and then click 

Reinstall using recommended settings. 

 

 

 

 

 

 

 

 

15) Click Yes for installing ‘.NET Framework 1.1 

Package’. 

 

 

 

 

16) The setup window asking about the license 

agreement is displayed. 

 

 

 

 

 

 

 

 

17) If select I agree to activate the Install button, Click 

Install to begin the installation. 
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18) All components related to .Net Framework are being 

installed.  

 

 

 

 

 

 

 

 

 

19) The installation of .NET Framework 1.1 is complete. 

Click OK to finish the installation. 

 

 

 

 

20) In the Exicycler3 folder of the provided CD, you can 

see setup.exe file and double click to have 

InstallSheild Wizard install the required items 

automatically. 

 

 

 

 

 

 

21) Click Next and go to the next step.  
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22) Click Install to begin the installation. If you want to 

change any settings or cancel installing, click Back 

or Cancel. 

 

 

 

 

 

 

 

23) Please wait while the InstallShield Wizard installs 

Exicycler3. 

 

 

 

 

 

 

 

 

24) The message indicating “InstallShield has 

successfully installed Exicycler3.” is shown. Click 

Finish to complete the installation  

 

 

 

 

 

 

 

25) On the Desktop, these icons (right) are created if the 

installation has been successfully completed. 
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26) In the C:\Exicycler3\Run folder, these folders and 

files are created. Copy ‘calibration’ folder from the 

Exicycler
TM

 96 CD into C:\Exicycler3\Run folder.  

Now you should connect Exicycler
TM

 96 system with 

a computer using provided USB cable. 

 

 

 

 

 

 

 

 

 

27) Check the USB cable connection between the 

Exicycler™ 96 and the computer. 

 

28) Power on the Exicycler™ 96. A power button LED 

will turn on red when the power is supplied properly.  

 

 

29) Press the power button again for a second to start 

Self-diagnosis. The POWER button LED starts 

blinking in green after two short beeps when the self-

diagnosis is complete. 

 

30) When Exicycler™ 96 is powered on for the first time, 

the computer searches for a new device. 

 

A) When an unsigned device is connected, the 

following message will be displayed. Click the 

message to view details. 

B) Because the device driver software is not yet 

installed, driver installation has to be continued. 

Please click Close. 
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31) To install the device driver and to confirm the device 

status, go to Control Panel\System and 

Security\System- Device manager. 

 

 

 

 

 

 

 

 

32) All devices connected to computer are displayed. 

The unsigned device is indicated with an 

exclamation mark. Point at this device and right-click 

and select Update driver software. 

 

 

 

 

 

33) When a prompt asking how to find device driver is 

presented, select Browse my computer for driver 

software. 

 

 

 

 

 

 

34) Click Browse to search for the appropriate driver 

software. 
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35) Select C: \Bioneer_Package\driver and click OK. 

 

 

 

 

 

 

 

 

 

 

 

 

36)  Selcect Install. Installation will be automatically 

started. 

 

 

 

 

37) Please wait while installation. This process needs 

several minutes.  

 

 

 

 

 

 

 

38) A window displays a message indicating that the 

installation was successful. Click Close to complete 

the installation. 
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39) Open ‘Device Manager’ and confirm the device 

driver installed. If USB test devixes 

(PLX)\PLX’Transfer device’ VID_0525&PID_1000) 

using Ncbulk.SYS has been installed properly, you 

can see the connected USB indicator. 

 

 

 

 

40) Click Run Exicycler3 icon to start Exicycler
TM

 96 

software. 

 

 

 

 

 

 

41) You can see this screen when the installation is 

completed successfully. The software version is also 

indicated.  

 

 

 

 

 

 

 

42) Now you are ready to operate the Exicycler
TM

 96 

system. To set your protocols, refer the user’s 

manual (provided). 

 

 

 

 

  



 
Exicycler™ 96 Real-Time Quantitative Thermal Block 

 

 
 

 
29 

www.bioneer.com 

 

 

 

Troubleshooting 

 

1. Appropriate calibration data does not exist  

 

1) The CD provided with Exicycler™ 96 has Calibration 

data for each device. Calibration data have to be 

copied into C:\Exicycler3\Run folder in order for 

normal function. If calibration folder does not exist on 

this path, following message will be displayed. 

 

 

 

2) The calbration files do not exist on the appointed 

path. Click OK to change the path. 

 

 

 

 

 

3) You should assign the path of the Calibration folder 

to be copied automatically. Click Open and you will 

see the following browser. 

 

 

4) After assigning the Calibration folder (ex. D: 

\Calibration), click OK.  
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5) The Copy Calibration window displays the path of 

calibration folder and serial number of your device. If 

the serial number matcheds with the connected 

Exicycler
TM

 96 system, click Copy button on the right 

side of the window.  

 

 

 

 

6) Please wait for a minutes to complete the copy. 

 

 

 

 

 

7) After copy of Calibration folder is complete, click OK 

to finish the process. Please confirm the connection 

between device and computer, and restart the run 

Exicycler3 software.  

 

 

 

 

 

 

2. The computer does not register Exicycler
TM 

96 device when lunching ‘Run Exicycler3’ software.  

 

This message means that the device power is not on 

or the appropriate device driver has not yet been 

installed on the computer. If you see this message 

despite the instrument power being on, then you 

should re-install the device driver to solve this 

problem. The driver installation steps are described in 

process number 30 of this manual. 
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3. An Error message is displayed when lunching ‘Run Exicycler3’ software.  

 

This message indicates that ‘.NET Framework 1.1’ 

has not yet been installed. Go to process number 13 

and re-install as described. 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. The Bioneer Package is not installed correctly. 

 

If an incorrect installation was performed previously, ‘Bioneer Package’ may not be installed correctly. Go to Control 

Panel-Programs Add/Remove and remove 4 programs from the computer - ‘Exicycler V3’, ‘Bioneer package’, ‘R 

for windows 2.11.1’ and ‘R/Scilab(D)COM Server3.01-B5’. After removing them from the computer, reperform the 

entire installation process. 
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System Operation and  

Calibration Preparation



 
Exicycler™ 96 Real-Time Quantitative Thermal Block 

 

 
 

 
33 

www.bioneer.com 

 

 

 

System Operation and Calibration Preparation 

 

Perform the calibration after verifying the installation of the Exicycler™ 96 and the computer. 

 

Powering On and Self-diagnosis 

 

1) Power on the Exicycler™ 96 by switching on a power 

supply button in the rear of the instrument. When power 

is supplied properly, a POWER button LED turns red. 

 

 

2) Press the POWER button for a second to start self-

diagnosis. 

 

 

 

IMPORTANT:  

The POWER button LED starts blinking in green after two short beeps when the self-diagnosis is complete. The 

Exicycler™ 96 is now ready to operate. The POWER button LED will turn red when the self-diagnosis fails or excessive 

physical shock is applied from outside. (e.g. Make sure that there are no objects placed in front of the door) Make sure 

that the POWER button LED is blinking in green before operating the Exicycler™ 96 to prevent mis-operation or 

damage. A result of the self-diagnosis is provided under “ExiConfig”. 

 

NOTE:  

You can stop the operation here and turn off the Exicycler™ 96 by press the POWER button for a second when it is 

blinking in green like Step 2. 

 

3) When the power button is blinking in green, you can 

either open or close a main door by pressing a DOOR 

button for a second. The power button is blinking in 

purple when the door is open and is back to green when 

the door is closed. 

 

Cautions:  

Do not place any obstacle in front of the system and do not load a plate or take out it when the door opens or close. 

It causes serious damages and will give severe injury. 
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Reagents and Consumable Products 

 

Various reagents and kits are required to perform a Real-Time PCR in the Exicycler™ 96 Real-Time 

Quantitative Thermal Block. Please refer to this section to obtain detailed information about the 

appropriate reagents and kits for your experiments. For ordering, please go to the 8, Ordering 

Information. 

 

PCR Premix Kit 

AccuPower
®
 Greenstar™ PCR PreMix Kit allows an easy and fast amplification in Exicycler™ 96. The AccuPower

®
 

Greenstar™ PCR PreMix Kit consists of Greenstar
®
 fluorescent dye, HotStart Taq DNA polymerase, and all of the 

PCR components. Therefore, add just template, primers, and MgCl2 to start your amplification. 

 

Optical 0.2 ㎖ 8-strip tube and 96-well plate 

You must use an optical tube or a plate when performing Real-

Time Quantitative PCR in the Exicycler™ 96. A standard tube or 

a plate can be also used for a conventional PCR without any 

fluorescent dyes. 

 

 

 

Optical sealing tape 

Seal up the optical tubes or plates tightly with the optical sealing 

tape for fluorescence detection. The sealing tape is available in 

the size of 96-well plate. Therefore, cut up the sealing tape as 

you need in case of using 0.2 ml 8-strip tubes. 

 

 

Caution:  

You must cut up the sealing tape with a box cutter, not scissors, when needed. The tape adhesive will be carried over to 

the surface of the sealing tape while cutting up the tape with scissors and make the tubes sealed with the tape stick to 

the heating lid of the Exicycler™ 96. The tubes stuck to the lid will drop inside the Exicylcer™ 96 when the lid is cooled 

down. Using at least 2 strips of 8-strip tubes at a time is also recommended to prevent this error. 

 

Warning: Chemical hazard 

AccuPower™ Greenstar™ PCR PreMix and AccuPower™ Dualstar™ PCR PreMix may cause eye and skin irritation, 

and respiratory tract irritation. To treat them, read the MSDS before use and follow the instructions if swallowed or 

inhaled. Wear appropriate protective eyewear, clothing, and gloves. 
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Calibration Using ExiCfg 
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Calibration Using ExiCfg 

 

Prepare to perform the calibration with a Calibration Kit (A-2060-A1). The calibration kit is designed for 

the Exicycler™ 96 Real-Time Quantitative Thermal Block (Version 3.0) and is not applicable to other 

Real-Time instruments. The calibration kit is comprised of 11 plates, a mask calibration plate, a 

background calibration plate, multi-channel calibration plates (9 different optical calibration plates of 

filter sets) present in the Exicycler™ 96. The calibration kit is available for reuse up to 3 times. For 

more information about the calibration kit, please see the following: 

 

 

Before Starting Calibration with the Calibration Kit 

Centrifuge 

Disposable plastic gloves 

Calibration Kit (A-2060-A1) 

 

Calibration Plate Preparation 

The calibration kit is shipped refrigerated or frozen and must be stored in the freezer upon receipt. 

Retrieve one Calibration Kit right before starting the calibration. 

 

1) Take out the Calibration Kit from the freezer. 

 

 

 

 

 

 

 

 

 

2) Take one of the sealed packs in the Calibration kit. 
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3) Allow the pack to warm to room temperature for at least 

10 minutes. 

 

 

 

 

 

 

 

 

4) Take out a calibration plate from its packaging. 

 

 

 

 

 

 

 

 

IMPORTANT:  

Pay particular attention to the calibration kit when handling. Wear disposable plastic gloves to help prevent 

contamination on the sealing tape covered the 96-well plate. Wipe out the surface of the plate with 70% Ethanol when it 

needs to be cleaned. 

 

NOTE:  

Do not vortex the calibration plate. A small amount of calibration solution is pre-aliquoted in each well, and it may be lost 

while vortexing. 

 

 

5) Place the calibration plate in a rack and centrifuge for 5 

minutes. 
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NOTE:  

During this step, it is important to spin down the calibration solution that remains on the side of the well and to remove 

air bubbles at the bottom of the well. 

 

 

6) Protect the calibration plate from direct sunlight after the 

centrifugation. Place the plate directly into the Exicycler™ 96. 

 

 

 

 

 

 

 

7) Put the calibration kit back into its packaging and return 

it to the freezer when the calibration is done. 

 

IMPORTANT:  

The Calibration Kit contains photosensitive components. Keep the calibration kit and the plate away from light during 

calibration. Put the calibration plate back into its packaging right away for reuse. 
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Calibration using ExiCfg 

 

The calibration must be performed prior to operating the Exicycler™ 96 Real-Time Quantitative 

Thermal Block. You can either transfer proper calibration data associated with a serial number from the 

installation CD to the computer or perform the calibration yourself. Install the Operation and Analysis 

Software for the calibration data transfer to the computer. For a reliable operation of the Exicycler™ 96, 

calibrating with the Exicycler™ 96 Calibration Kit is recommended. The calibration must be done when 

moving the physical location of the Exicycler™ 96 or when changing a light source lamp. A periodical 

calibration every 6 months helps maintain the optimum condtion of the Exicycler™ 96. 

 

Use the ExiCfg program to calibrate the Exicycler™ 96. The ExiCfg calibrates as well as diagnoses the 

systemical condition of the Exicycler™ 96. Make sure that you are fully trained for handling the ExiCfg 

before starting calibration. Otherwise, authorized staff is only allowed to manage the ExiCfg. Mis-use of 

the ExiCfg by unauthorized staff may cause serious damage in the Exicycler™ 96. 

 

The calibration is carried out with 4 steps, Warming up the lamp > Mask calibration > Background 

calibration > Multi-Channel calibration. 

 

Mask Calibration 

 

1) Power on the Exicycler™ 96 by pressing the POWER 

button. 

 

 

 

 

 

NOTE:  

Make sure the POWER button is blinking in green after the self-diagnosis prior to starting the calibration. 

 

2) Go to ‘C:\Exicycler3\Run’ and double click ExiCfg.exe. 

 

 

 

 

 

 

POWER  
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3) Click Lamp warming to turn on the lamp. A progress bar 

of the Lamp warming will start right after ‘The lamp is 

turned on’ message appears on the ‘History’ box. Do not 

click any buttons until the progress bar finishes. 

 

 

 

 

 

IMPORTANT: 

It usually takes about 30 seconds for the message ‘The lamp is turned on’ to appear on the ‘History’ box. If the message 

does not appear in 5 minutes, turn off the Exicycler™ 96 and turn it on again after 5 seconds. In case of an abnormal 

shutdown like this, wait about 5 minutes, then click Lamp warming to turn on the lamp again. It takes approximately 10 

minutes to reach the maximum light intensity there after. Therefore, wait until the progress bar of the Lamp warming 

finishes before proceeding further. 

 

 

4) Press the DOOR button to open the door. 

 

 

 

 

 

 

 

 

5) Place the Mask calibration plate with the A1 position at the 

top-left of the block. 

 

 

 

 

 

 

 

NOTE:  

You must perform the Mask calibration first prior to other calibrations. 

DOOR 
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IMPORTANT: 

It is important to load the calibration plate in the right position. A misplaced plate may cause damage or technical 

problems. 

 

6) Press the DOOR button again to close the door. 

 

 

 

 

 

 

 

 

 

7) Click Mask Calibration button. 

 

 

 

 

 

 

 

 

 

 

8) Click Start button in the ‘Mask Calibration’ window. 

 

 

 

 

 

 

 

 

 

 

DOOR 
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NOTE: The calibration time is approximately 10 minutes depending on the condition of the Exicycler™ 96 and the 

computer. 

 

9) When the mask calibration is complete, click OK. 

 

 

 

 

 

 

 

 

 

 

 

 

NOTE:  

The door will open when the mask calibration is successfully complete. Put the plate back into its packaging and return 

it to the freezer. 

 

 

Warnings: High temperature 

Wait at least 5 seconds before taking out the calibration plate from the 96-well block. The calibration plate is heated to a 

temperature of 100°C and may cause a burn. 

 

 

10) Click Close in the ‘Mask Calibration’ window. 
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11) The ‘Mask Calibration’ frame will turn blue when the 

calibration is successfully complete. 
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Background Calibration 

 

 

1) Press the DOOR button to open the door. 

 

 

 

 

 

 

 

 

NOTE:  

This step is omissible when performing the background calibration followed by the mask calibration. 

 

2) Place the Background calibration plate with the A1 position 

at the top-left of the block. 

 

 

 

 

 

 

 

IMPORTANT:  

It is important to load the calibration plate in the right position. A misplaced plate may cause damage or technical 

problems. 

 

3) Click Background calibration button. 

 

 

 

 

 

 

 

 

DOOR 
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4) Click Start in the ‘Background Calibration’ 

window. 

 

 

 

 

 

 

 

 

NOTE: The background calibration time is approximately 10 minutes depending on the condition of the Exicycler™ 96. 

 

 

5) When the background 

calibration is complete, click OK. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

NOTE: The door will open when the background calibration is successfully complete. Put the plate back into its 

packaging and return it to the freezer. 

 

 

Warnings: High temperature 

Wait at least 5 seconds before taking out the calibration plate from the 96-well block. The calibration plate is heated to a 

temperature of 100°C and may cause a burn. 
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6) Click Close in the ‘Background Calibration’ 

window. 

 

 

 

 

 

 

 

 

 

 

7) The ‘Background Calibration’ frame will 

turn blue when the calibration is 

successfully complete. 
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Multi-channel Calibration 

 

 

1) Press the DOOR button to open the door. 

 

 

 

 

 

 

 

 

NOTE: This step is omissible when performing the background calibration followed by the mask calibration. 

 

2) Click Multi-Channel Calibration button. 

 

 

 

 

 

 

 

 

3) Select fluorescence dyes in the ‘Multi-Channel Calibration’ 

window for the calibration. 

 

 

 

 

 

 

 

 

 

NOTE:  

9 dyes are available for calibration. 

 

DOOR 
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NOTE:  

For a selective multi-channel calibration of your desirable dyes, select check boxes of the dyes. 

 

 

4) Click Start. 

 

 

 

 

 

 

 

 

 

 

5) Prepare the calibration plate with a dye X (i.e. “FAM”) 

when ‘Attach the plate named ‘X’ (i.e. “FAM”) on the bath’ 

message appears. 

 

 

 

 

 

 

 

 

 

 

6) Place the Multi-Channel calibration plate with the A1 

position at the top-left of the block. 
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IMPORTANT: 

It is important to load the calibration plate in the right position. A misplaced plate may cause damage or technical 

problems. 

 

 

7) Click Yes in the ‘Confirm’ window. 

 

 

 

 

 

 

 

 

 

 

NOTE: An approximate calibration time for each dye is 5 minutes. 

 

 

8) The door will open when the calibration is successfully complete. 

 

NOTE: Put the plate back into its packaging and return it to the freezer. 

 

 

Warnings: High temperature 

Wait at least 5 seconds before taking out the calibration plate from the 96-well block. The calibration plate is heated to a 

temperature of 100°C and may cause a burn. 
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9) Prepare the calibration plate with a dye X (i.e. “SYBR 

Green”) when ‘Attach the plate named ‘X’ (i.e. “SYBR Green”) 

on the bath’ message appears. 

 

 

 

 

 

 

 

 

 

10) Click Start to repeat steps 4 through 8. 

 

 

 

 

 

 

 

 

 

 

 

 

 

11) When the multi-channel calibration is complete, click OK. 
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12) Click Close in the ‘Multi-Channel Calibration’ window. 

 

 

 

 

 

 

 

 

 

 

 

13) The ‘Multi-Channel Calibration’ frame will turn blue 

when the calibration is successfully complete. 

 

 

 

 

 

 

 

14) Go to Calibration>Test Function>Lamp Off 

from the top menu bar. 

 

 

 

 

 

 

 

 

 

15) Wait for at least 5 minutes to switch off main power of 

the Exicycler™ 96. The cooling fan will continue to run to 

cool down the lamp, althought you already turned the lamp 

off. Shutting down Exicycler™ 96 before cooling down the 

lamp will reduce the lamp lifetime. 
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16) Power off the Exicycler™ 96 by pressing the POWER 

button. 

 

 

17) Turn off the Exicycler™ 96 using the main power switch 

located on the back of the Exicycler™ 96. 

 

 

 

 

 

 

18) Go to Information>Exit from the top menu bar to close 

ExiCfg program. 

 

 

 

 

 

 

 

On/Off 

Switch 
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Running Real-Time PCR 

Using Exicycle™ 96 Softwar
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Starting ‘Run Exicycler’ software 

 

1) Ensure that the Exicycler™ 96 is in the “Standby” 

position. The POWER button must blink in green. Double 

click Run Exicycler3 icon on the desk top to start Run 

Exicycler3. 

 

 

 

 

 

 

 

 

 

 

 

2) System Check window will pop up. 

 

 

 

 

 

IMPORTANT:  

The following error message will appear if the Exicycler™ 96 is not 

powered on. Power on the Exicycler™ 96 by pressing the power 

switch in the back of the Exicycler™ 96 and double click Run 

Exicycler3 on the desk top again. 

 

 

 

IMPORTANT:  

The following error message will appear whether the calibration has not been 

performed in the Exicycler™ 96 or if the calibration data is lost accidently. Close the 

Run Exicycler3 and perform the calibration. 
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3) The following window will appear when System Check is complete. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

a. Menu consists of File, Setup, Run, Window, and Help. 

b. Experiment Information displays a file name, a user name, and elapsed and estimated finish time. 

c. Protocol Information displays a cycling protocol in detail. 

d. Well information displays sample and probe specification for each well. 

e. Temperature Profile displays a temperature curve of the cycling protocol. 

 

4) Go to Setup > Probe from the top menu. 

 

 

 

 

 

IMPORTANT:  

9 different probe options are available in the Exicycler™ 96. Each probe option includes specifications of a fluorescence 

dye and a quencher. You can either select one of existing probe options in Probe List or add your own. Ensure you 

specify an appropriate probe option for accurate data analysis. 

a. Menu 

 

b. Experiment Information 

c. Protocol Information 

d. Well Information 

e. Temperature Profile 
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5) Probe Information window will appear. 

Select one or click Add to add additional 

probe. 

 

 

 

 

 

 

 

 

 

6) Enter SYBR_AQ in the Name field. 

 

 

 

 

 

 

 

 

 

NOTE:  

In the Dye drop-down list of the Add Probe window, select SYBR_Green. Select None in the Quencher drop-down list. 

Select your desirable color for display and then click OK. 

 

 

7) Check if your new probe is shown under 

the list, and then click Save. 
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8) Go to File > Design Experiment to 

design the new experiment. 

 

 

 

 

 

9) Quick Start window will appear as follows: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

a. Master, Protocol, and Plate: You can create, save, or open a file. 

b. User: Select or create the user name for personal account management. 

c. Protocol Information: Displays a cycling protocol in detail. 

d. Temperature Profile: Displays a temperate curve of the cycling protocol. 

e. Protocol setting: Specifies protocol specifications such as temperature, time, and a number of cycles. 

 

 

10) Click Incubate tab and enter a temperature in the 

Temperature field and then a time in the Time field. 

 

 

 

 

d. Temperature Profile 

c. Protocol Information 

a. Master, Protocol, Plate 

 /Protocol/Plate 

b. User 

e. Protocol setting 
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a. Incubate sets up a temperature and a time for the thermal block. 

Time Increment sets up time increment per second. 

Temperature Increment sets up temperature increment per second. 

Ramping Rate sets up a ramping rate. 

b. Scan measures fluorescence signals emitted from samples. 

c. Goto specifies a starting step of a thermal cycling and a number of cycles. 

d. Melting sets up starting temperature and ending temperature for melting curve analysis to distinguish 

specific and nonspecific amplification products when SYBR Green is used for Real-Time PCR. 

e. Store keeps the 96-well thermal block at a set temperature until you stop the Exicycler™ 96. It is not 

recommended to use the Store step when it is excessively humid. 

f. Pause is used to pause the Exicycler™ 96 when it is necessary to check samples during 

experimentation. The door of Exicycler™ 96 will open when the Pause step is inserted in the protocol 

file. Click Run to resume the experiment. 

g. Hottop sets up a temperature for the heating lid. 

 

NOTE: 

 

Scan is used to detect fluorescence signals from samples. The fluorescence signals are measured for about 25 

seconds at the set temperature of the previous incubation step. If the Scan step is not included in the protocol file, 

a convetional PCR will be carried out without scanning fluorescence signals. 

 

Melting sets up starting temperature and ending temperature for melting curve analysis to distinguish specific and 

nonspecific amplification products when SYBR Green is used for Real-Time PCR. Enter the starting temperature in 

the From field, the ending temperature in the To field, a temperature interval within a range of 0.3°C to 2°C in the 

Between field, and a hold time within a range of 1 second to 99 hours 59 minutes and 59 seconds in the Hold 

Time field. 

 

Store keeps the 96-well thermal block at a set temperature after the thermal cycling is complete. The heated lid will 

start cooling down automatically. The Exicycler™ 96 will keep the main door closed and will continue to store the 

thermal block at the set temperature until you stop the Exicycler™ 96. If the Store step is not inserted into the 

protocol file, the main door will open automatically when the thermal cycling is done. 

 

Hottop Check Box sets up a temperature for the heating lid within a range of 90°C to 110°C. The default 

temperature is 100°C. When the check box is unselected, the heating lid will not be heated. 
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11) Click Append to add the new step into the protocol. 

 

a. Append button is used when you want to add new steps into the 

protocol. 

b. Update button is used when you want to make changes on steps. 

c. Delete button is used when you want to delete steps from the protocol. 

 

 

 

 

 

 

 

 

 

12) Click Incubate tab to add another Incubation step 

and then click Append. Repeat steps 2 through 4 if 

needed. (i.e. 94°C 30 sec / 55°C 30 sec / 72°C 30 

sec). 

 

 

 

 

 

 

NOTE:  

To edit Incubate steps, click one of the steps in the Protocol Information window and edit. Click Update to change the 

protocol. 
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13) Click Scan tab and then Append. 

 

 

 

 

 

 

 

 

 

14) Click Goto tab and select a starting step (i.e. “2”) in 

the Line drop-down list. Enter a number of cycles (i.e. 

“35”) in the Cycle field, and then click Append. 

 

 

 

 

 

 

15) The protocol is created and saved. The Temperature 

Profile window displays an estimated temperature 

curve as follows: 

 

 

 

 

 

 

 

 

16) Click Melting tab to perform melting analysis. Enter 

the starting temperature in the From filed (i.e. “60”), 

the ending temperature in the To field (i.e. “94”), a 

temperature interval in the Between field (i.e. “1”), 

and a hold time in the Hold Time field (i.e. “1”). 
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17) Click Append. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

NOTE:  

The door of the Exicycler™ 96 will open automatically when the Real-Time PCR has run by a protocol that does not 

include the Store step. If the Store step is included in the protocol, you must stop the Exicycler™ 96 first by clicking 

Stop button in order to open the door. Otherwise, the Exicycler™ 96 will continue to store samples in the thermal block at 

the set up temperature. 

 

IMPORTANT:  

In order to edit the heating lid option, select the check box in the Hottop and enter a desirable temperature. The default 

temperature is 100°C. The heating lid will not be heated if the check box is unselected. 

 

 

18) Enter a protocol file name in the Protocol field at 

the top left (i.e. “Test”) and then click  button 

to save the protocol. 

 

 

 

 

 

 

 



 Exicycler™ 96 Real-Time Quantitative Thermal Block 
 

 
 

 
62 

www.bioneer.com 

 

 

 

Add probe 

 

NOTE: 

Click  button from the Quick Start to open the saved Master, Protocol and Plate files when needed. 

 

19) Once the protocol is saved, click Plate tab to create 

a plate file. The Plate window will appear as follows: 

 

 

 

 

 

 

 

 

 

 

a. 96-well plate position specifies well locations for samples. 

b. Name/Count/Probe displays a name, probe information for each sample. 

c. Probe Name/Flu. Dye/Quencher/Type/Concentration specifies a name, a fluorescence dye, a quencher dye, 

a type, and a concentration for each sample. 

d. Protocol/Plate tab switches between the Protocol Information and the Plate Information windows. 

e. Sample Name enters a sample name. 

Assign specifies the information of each well such as probe and type. 

Add Probe adds the probe to use in experiment. 

 

NOTE:  

Ensure that you specify appropriate information (i.e. probe set up and sample type) for each well before running 

experiment in order to generate accurate data. 

 

20) Click Add Probe, the Add Probe window will appear. 

 

 

 

 

 

 

 

d. Protocol/Plate Tab 

a. 96-well plate position 

b. Name/Count/Probe 

e. Sample Name 

Assign 

Add probe 

c. Probe Name, Flu. Dye 
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21) Select appropriate probes, and then click OK. 

 

 

 

 

 

 

 

 

 

 

a. Probe Name: displays the name assigned by the user. 

b. Fluorescent Dye: displays a name of fluorescence dye assigned by the user. 

c. Quencher: displays a name of a quencher assigned by the user. 

 

22) The probe is loaded and shown as follows: 

 

 

 

 

 

 

 

 

23) Select wells from the 96-well plate diagram. 

 

 

 

 

 

 

 

 

NOTE:  

Use the left mouse button when selecting a single well. When selecting a range of cells, click the first cell in the range, 

and then drag to the last cell. You can also select cells in a row or column by pressing CTRL and clicking the row or 

column heading. To select all cells in 96-well plate, click the cell  at the top left corner of the diagram.  

Drag! 

Click!  

Probe Name 

Fluorescent Dye 

Quencher 
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24) Click the probe option cell and then select STD in the 

Type drop-down list. Select the check box of Probe 

Name and then click Assign. 

 

 

 

 

 

 

 

a. Sample represents unknown samples. 

b. STD stands for a standard sample of a known concentration. Absolute Quantification 

c. NTC stands for No Template Control and is a sample without a template. 

d. IPC stands for Internal Positive Control and is a sample that monitors the PCR run during Existence / 

Nonexistence reaction. It will also diagnose the cause of the negative result of PCR. 

e. IPC- is a sample that is used as a template and contains a reagent to prevent the IPC reaction during 

Existence / Nonexistence reaction. IPC- is not amplified during the Real-Time PCR. 

 

25) Click the well D3 and enter concentration. For 

example, enter ‘1000000’ for a concentration of 10
6
-

copy and then click Assign. Repeat this for wells D4 

through D8 with concentrations of serial diluted 

standards. 

 

 

 

 

 

26) Select wells E3 through E8 in the plate diagram. 

Select Sample in the Type drop-down list, and the 

click Assign.  

 

 

 

 

 

 

Sample 

STD 

NTC 

IPC- 

IPC 

Sample 
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27) Select cells D3 through E8 and enter a sample name 

in the Sample Name filed. Click Sample Name to 

save the sample name. 

 

 

 

 

 

 

 

28) Verify information on each well in the 

Name/Count/Probe window. 

 

 

 

 

 

 

 

 

29) Enter a plate name in the Plate field (i.e. Test) and 

then click  button to save the plate file. 

 

 

 

 

 

 

 

 

 

30) The protocol file and plate file are saved. Enter a 

master file name in the Master field (i.e. Test) and 

then click  button to save the master file. 

 

NOTE: Save the master file, the protocol file, and the plate file by clicking button. You can open the saved master 

file by clicking  button from the Quick Start. The master file is loaded along with the protocol file and the plate file. 

Sample Name Field 

Name/Count/Probe 
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A1 Position 

31) Click OK at the top right to display the go back to 

the main window. 

 

 

 

 

 

 

 

 

 

 

 

 

32) Ensure the POWER button in the front of the 

Exicycler™ 96 is blinking in green. 

 

 

 

 

 

 

33) Press the DOOR button for a full second to open the 

door. Load the 96-well plate with samples with the A1 

position at the top-left of the block. 

 

 

 

 

 

 

 

 

 

 

 

 

A1 Position 

Power off  Standby 
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34) Verify the master file and go to Run > Run from the 

top menu bar or click the Run button. 

 

 

 

 

 

 

 

 

 

 

35) Enter a data name (i.e.Sample_AQ) in the Dataname window 

and click Ok. If you do not enter the data name, default name 

will be used. 

 

 

 

 

 

36) The following three message boxes will appear in the 

following order. 

 

a. The message will appear when closing the door of 

the Exicycler™ 96 if the door was open. 

 

 

 

b. The message will appear when checking the lamp 

condition. 

 

 

 

c. The message will appear while the lamp is turning 

on. 
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d. The message will appear when checking if the 

lamp is on and initializaing the Exicycler™ 96. 

 

 

 

 

37) The main window will 

appear when the 

progress bar finishes 

without any problems. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

a. Scan window displays a curve of amplification in real time during PCR. 

b. Melting windows displays a melting curve in real time when the melting step is included in the protocol file. 

c. Temperature Profile displays a temperature profile and in real time 

d. Experiment Information displays information for the experiment currently in progress. 

e. Protocol Information highlights the step currently running. 

f. Well Information displays set up details for each well when selecting either Probe or Type in the Graph 

Color Setting drop-down list. To display the curve of amplification, select well from the 96-well plate diagram 

and click the check box from the probe option. 

 

 

 

 

 



 Exicycler™ 96 Real-Time Quantitative Thermal Block 
 

 
 

 
69 

www.bioneer.com 

 

 

 

38) Go to Run > Stop to stop the Exicycler™ 96 or click 

the Stop button. 

 

 

 

 

 

 

 

 

39) Go to Run > Pause to pause the Exicycler™ 96 or 

click the Pause button. 

 

 

 

 

 

 

IMPORTANT:  

If the pop up window remains more than 5 minutes after running the Exicycler™ 96 or if the temperature profile does 

not display anything in the main window, turn off the Exicycler™ 96 and turn it on again. Start Run Exicycler3 again 

and run the Exicycler™ 96 again. If the same error keeps occurring, please contact us for customer service. 

 

IMPORTANT:  

It is recommended to re-start the Exicycler™ 96 at least 10 minutes after the previous Real-Time PCR run has finished. 

Continuous operation without a break will reduce the lamp life time and cause errors. 

 

NOTE:  

Do not turn off the Exicycler™ 96 while the heating lid is warming up. While the heating lid is heated to the set 

temperature, the 96-well block maintains at 25°C. The thermal cycling will start when the heating lid reaches to the set 

temperature and the lamp is stabilized. 

 

NOTE:  

*.ex3 file is created under a folder designated by the user after the experiment is complete. The user can analyze the 

*.ex3 file using the Exicycler™ 96 Analysis Software to generate analysis data. Please refer to Analyzing Data using 

Analysis Software for data analysis. 

 

Click! 

Click! 
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Performing System Diagnosis using ExiCfg 

 

1) Power on the Exicycler™ 96 by pressing the POWER 

button. 

 

 

 

 

 

 

 

 

 

2) Go to  ‘C:\Exicycler3\Run’ and double click ExiCfg.exe 

to start the program. 

 

 

 

 

 

 

 

3) Go to Information > Self Test. 

 

 

 

 

 

 

 

 

 

 

NOTE: 

‘USB Communication is NOT initialized’ message box will pop up if the Exicycler™ 96 is powered off or if the cable 

connection between the Exicycler™ 96 and the computer is not firmly connected. 

 

POWER  
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4) Click Start in the Self Test window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

IMPORTANT:  

Make sure that there are no objects placed in front of the door while performing Self Test. 

 

5) All of the self-diagnosis tests pass completely without 

any problems, OK signs will show up in green. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

NOTE:  

The self-diagnosis is complete with two short beeps. 
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6) When any of the self-diagnosis tests fail, NG signs will 

appear in red. 

 

 

 

 

 

 

 

 

 

 

 

 

NOTE:  

Any problems caused during self-diagonsis are recorded in ‘Error log’. 

 

7) Go to Information>Error Log from the top menu bar to 

see the problems. 

 

 

 

 

 

 

 

 

 

 



 Exicycler™ 96 Real-Time Quantitative Thermal Block 
 

 
 

 
73 

www.bioneer.com 

 

 

 

 

 

 

 

 

Troubleshooting 
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Troubleshooting 

Please take recommend action for each observation. Contact Bioneer Customer Service Center if problem 

continues after the recommended action. 

 

 

Observation Recommended Action 

The Exicycler™ 96 does not start. 

 Make sure the power cable is firmly connected to the wall circuit, and then 

switch on the power supply button in the rear of the Exicycler™ 96. 

 Check a fuse box located down by the power switch in the rear of the 

Exicycler™96 . Change the fuse if it has blown. 

Errors occur either after or during 

Self-diagnosis (POWER button in 

red). 

 The lamp may still be cooling down or the Self-diagnosis is still running. If the 

POWER button does not turn back to green in 5 minutes, power off the 

Exicycler™ 96 and back on again. If the same error occurs, please contact 

Bioneer Customer Service Center for help. 

 Power off the Exicycler™ 96 if unexpected errors occur. Power back on the 

Exicycler™ 96 again to cool down the lamp and wait for 3 minutes. Press the 

POWER button to start Self-diagnosis. Please contact Bioneer Customer 

Service Center if the same error keeps occurring. 

No communication detects 

between the computer and the 

Exicycler™ 96 . 

 Make sure that the USB cable is firmly connected to the computer. 

 Ensure you use the USB cable provided with the Exicycler™ 96 in order to 

connect the computer and the Exicycler™ 96. 

 Check if the Exicycler™ 96 is in the “Standby” position. The POWER button 

must blink in green. Power off the Exicycler™ 96 and back on again if the 

POWER button still blinks in red. 

The POWER button or the DOOR 

button does not work. 

 Make sure that the power cable is firmly connected to the wall circuit, and then 

switch on the power supply button in the rear of the Exicycler™ 96. 

 The Self-diagnosis may be still running. Wait until the Self-diagnosis is 

complete and the POWER button blinks in green. 

The Exicycler™ 96 has stopped 

running. 

 Check if the electricity is supplied properly. Operate an AVR or UPS if needed. 

 Disable Screen Saver and Monitor Power in the Control Panel. 

 Ensure you use the USB cable provided with the Exicycler™ 96 to connect the 

computer and the Exicycler™ 96. 

 Check if the USB driver is installed properly. If not, reinstall it again. 

 Do not plug in any other USB cables in the computer while the Exicycler™ 96 

is running to prevent friction between the Exicycler™ 96 and the computer. 
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Observation Recommended Action 

The Exicycler™ 96 does not start 

a thermal cycling. 

 The Exicycler™ 96 may still be in the “Standby” position in order to warm up 

the lamp. Warming up the lamp takes about 10 minute. The thermal cycling will 

start automatically after the lamp warm up is finished. 

Low intensity fluorescence signal 

is detected. 

 Either examine fluorescence signal of the probe used for Real-Time PCR or 

use a new kit. 

 The PCR product amplified may be too long or there may be non specific 

products. Perform gel electrophoresis to determine the presence of 

amplification product or adjust an annealing temperature or Mg2
+
 concentration 

if needed. 

 Perform the calibrations again to adjust the light intensity of the lamp. 

Excessively high intensity 

fluorescence signal is detected. 

 Adjust concentration of the probe used for Real-Time PCR. 

 Make sure you use an appropriate probe system. 

 Adjust and optimize the PCR sample conditions. 

The software shuts down 

abnormally. 
 The USB driver has not been installed properly. Reinstall the USB driver. 

PCR sample is evaporated. 

 Check if the heating lid works or if the sample tubes or plates are completely 

sealed with the sealing tape. 

 Ensure the heating lid option is set up correctly. The Hottop Check Box must be 

selected and correct temperature must be set up. 

 A small amount of evaporation is not critical. 

 It is recommended that you use Bioneer kits and reagents to prevent PCR 

sample evaporation. 

No PCR products are amplified. 
 Perform gel electrophoresis to determine the presence of amplification 

products. Adjust an annealing temperature or Mg2
+
 concentration if needed. 

No fluorescent signal is detected 

although PCR product is 

amplified. 

 Either examine fluorescence signal of the probe used for Real-Time PCR or 

use a new intercalating dye. 

 Perform the calibrations again to adjust the light intensity of the lamp. 

Pop-up message during 

calibration process: 

Background Calibration finished will appear if the Background Calibration is 

successful. 

Can't Read Data from EEPROM will appear if the computer can not read data 

from the Exicycler™ 96. Check if the USB cable is firmly connected between the 

computer and the Exicycler™ 96. 
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Observation Recommended Action 

Pop-up message during 

calibration process (continued): 

Can't close program during PCR will appear if you attempt to close the 

Exicycler™ 96 software while PCR is still running. 

Do you want to stop PCR? will appear if you click Stop button during the Multi-

channel Calibration. 

Do you add plate on the bath? will appear to make sure that the calibration 

plate is loaded in the thermal block prior to PCR. 

Mask Calibration finished will appear if the Mask Calibration is complete. 

Multi-Channel Calibration finished will appear if the Multi-channel Calibration is 

successful. 

Need to set up Machine ID will appear if an instrument ID has not been set up 

for the Exicycler™ 96. Assign the ID using the Exicycler™ 96 software. 

No matching calibration data with machine will appear if the instrument ID 

does not match the ID from the Exicycler™ 96 software. Set up the instrument ID 

using the Exicycler™ 96 software. 

Turn off the lamp will appear if you attempt to end ExiCfg while the lamp is still 

on. To close ExiCfg, turne off the lamp first and then close the ExiCfg. 

Please load Mask Calibration Information first will appear if you attempt to 

perform the Uniform Calibration before the Mask Calibration. 

USB Communication is NOT Initialized will appear if the computer and the 

Exicycler™ 96 do not communicate with each other. Check if the USB cable 

between the computer and the Exicycler™ 96 is firmly connected. 

You must insert New Dye Name will appear if a new name is not assigned for a 

custom dye. 

You must select at least one dye will appear if you start the Multi-channel 

Calibration without selecting dyes. You must select at least one fluorescent dye 

for the calibration. 

Error message when running the 

Exicycler™ 96 software: 

Can't exit program during PCR will appear if you click Stop button in the 

Exicycler™ 96 software while PCR is still running. 

Can't open data during PCR will appear if you select File > Open Data from the 

top menu while PCR is still running. 

Can't Pause during Melting Protocol will appear if you click Pause button while 

the melting step is still running. 

Can't read data from EEPROM will appear if errors occur during PCR and the 

computer cannot read data from the Exicycler™ 96. 
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Observation Recommended Action 

Error message when running the 

Exicycler™ 96 software 

(continued): 

Can't read Plate Information will appear if you attempt to open an outdated 

plate file. 

Can't Stop during Melting Protocol will display if you attempt to stop the 

Exicycler™ 96 software while the melting step is running. 

Communication between machine and S/W was not initialized will display if 

you click Run button when the Exicycler™ 96 is not ready. 

Do you want to stop PCR? will display if you click Stop button while PCR is still 

running. 

Fail to load calibration information will appear if the computer fails to read the 

calibration data from the Exicycler™ 96. Go to C: \Exicycler3 to check if the 

calibration folder and file exist. 

Melting Protocol can't be in Cycle Region will appear if the melting step is 

inserted within a thermal cycling. 

Need to replace the Lamp will appear if the lamp intensity drops below 60% of 

the normal lamp intensity. Replace the lamp. 

No matching calibration data with Machine. Can't Run! will appear if you click 

Run button when the Exicycler™ 96 ID and the calibration data ID do not match. 

No matching calibration data with machine will appear if the Exicycler™ 96 ID 

and the calibration data ID do not match. 

Please insert any protocol before inserting Goto Protocol will appear if the 

Goto step is inserted in the first line of a protocol file. 

Please insert Data name will appear if you have not entered a name for data 

prior to PCR running. 

Probe Information was changed, do you want to cancel this? will appear if 

you click the Cancel button without saving the edited probe Information. 

Probe using same filter is assigned will appear if you assign more than 2 

probe options within the same wavelength range. 

Ramping rate option Must be inserted between Incubation steps will appear 

if you insert a ramping rate option in a wrong position of the protocol file. 

Set Probe Name will appear if you have not entered a new name for the custom 

probe in the Add Probe window. 

UserName was already in User List will appear when entering an existing 

name for User set-up. 

You must select Dye and Quencher will display if the dye and quencher set up 

has not been selected in the Add Probe window. 
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Ordering Information and Warranty 

 

 

Product 

A-2060 Exicycler™ 96 Real Time Quantitative Thermal Block 

Accessories 

A-2060-A1 AccuPower® Calibration Kit for Exicycler™ 96 

Plastic consumables 

3111-41 Adhesive Optical Sealing Film, 100 sheets 

3111-50 0.2 ml Opaque White 8-strip PCR Tube, 250 Strips 

3111-52 Opaque White 96-well Semi-skirted PCR Plate, 25 Plates 

Premix & Reagent 

K-6200 AccuPower® Greenstar™ qPCR PreMix, Exicycler 8-well strip, 50 µl, 12 strips 

K-6203 AccuPower® Greenstar™ qPCR PreMix, Exicycler 96-well plate, 50 µl, 1 plate 

K-6253 AccuPower® 2X Greenstar qPCR Master Mix / 100Rxn, 50 μL reaction 

K-6254 AccuPower® 2X Greenstar qPCR Master Mix / 200Rxn, 50 μL reaction 

K-6110 AccuPower® DualStar™ qPCR PreMix, Exicycler 8-well strip, 50 µl, 12 strips 

K-6113 AccuPower® DualStar™ qPCR PreMix, Exicycler 96-well plate, 50 µl, 1 plate 

K-6600 AccuPower® Plus DualStar™ qPCR PreMix, Exicycler™ 96, 12 strips, 50 µl 

K-6603 AccuPower® Plus DualStar™ qPCR Master Mix(2X), 2.5ml, 100 rxn 
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WW aa rr rr aa nn tt yy  
 

 

This Bioneer brand product, as supplied and distributed by Bioneer Corporation, is warranted by Bioneer 

against manufacturing defects in materials and workmanship for a limited warranty period of one year. 

 

Product Exicycler™ 96 Real-Time Quantitative Thermal Block 

Catalog No. A-2060 

Serial No.  

Date of Purchase      /      /     (dd/mm/yy) 

Warranty Period For 12 months from purchasing date 

 

 

1. How to request warranty service 

Please fill out the service request form attached to this manual and submit it to us by fax or mail. For prompt 

service, please have the problem log and the experimental file ready before contacting us. For more details, 

please contact Bioneer Customer Service Center or your local distributor. You may call us at 1588-9788 for 

minor problems. The service request result will be notified to you within 7 business days and the system will be 

repaired or replaced within 14 business days. 

 

2. Repairs under warranty 

During the one-year warranty period, Bioneer will repair all defective products free of charge. 

 

3. Exclusion from warranty 

The product is excluded from warranty if: 

 The product has been found to be defective after expiry of the warranty period. 

 The product has been subjected to misuse, abuse, or unauthorized repair, whether by accident or 

other cause. 

 Product is damaged beyond repair due to nature disaste
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WWaarrrraannttyy  SSeerrvviiccee  RReeqquueesstt  FFoorrmm  

Product Exicycler™
 
96 Real-Time Quantitative Thermal Block 

Catalog No. A-2060 Serial No.  

Date of request  

Date of purchase  

Service 

 

Issue 

* Please list one service issue or concern per line 

Issue 1  

Issue 2  

Issue 3  

Issue 4  

Customer 

 

Information 

Name  

Company  

Name  

Contact Phone: Fax: 

E - mail  



 

 

 

 


